ANSWER KEY

Touchpad PLAY Ver 1.0

Class-7
1. Number System
A. 1.(o 2. (a) 3.(0) 4. (a)
B. 1.0 2.2 3. decimal number 4.10 5.8 6. binary
Let's Do It

A. 1.. Octal number system is used as a shorthand representation of long binary numbers.
2. 4 Bits = 1 nibble.

3. The total number of digits used in a number system is called its base.

1

. A number system is simply a method of counting. There are 4 types of number systems in
computer such as binary number system, decimal number system, octal number system, and
hexadecimal number system.

2. To convert a decimal number into a binary number, follow these steps:
Step 1 Divide the decimal number by 2 (the base of the binary number system).
Step 2 Note down the quotient and the remainder.

Step 3 Divide the quotient obtained again by 2 and note down the resulting quotient and
remainder.

Step 4 Repeat the procedure till you reach a quotient less than 2.

Step 5 List the last quotient and all the remainders (moving from bottom to top). You have
your binary number.
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3. Rules to subtract two binary number:

1. (10111.011),

X Y X-Y
0 0 0-0=0
0 1 0-1=1
(borrow 1, so that 10 -1 = 1)
1 0 1x0=1
1 1 1x1=0

Ix22+0x2+1x22+1x2+1x20+0x21+1x22+1x23

= 1x16+40+1x4+1x2+1x1+0+1/4+1/8
= 16+4+2+1+025+0.125

= (23375),
2. @ @ Borrow
1 0 0 1 1 0
- 1 1 0 1
1 1 0 0 1
@@@ Carry
3. (a) 1 0 0 0 (b) T o 1 1
+ 1 0 1 + 1 0 1
1 1 1 1 0 0 0 0
@ Carry @@@ Carry
(© 1 0 0 1 (d) 1T 1 1 1
¥ 0 1 + 1 1 1
1 1 1 0 1T 1 1 1 0
@ Carry
(e) 1 1 0 0 1
+ 1 0 1 0 1
1T 0 1 1 1 0
4. (a) 2 |39 (b) 2 |72
2 [19-1 2 [36-0
2 [ 9-1 2 [18-0
2| a-1 2] 9-0
2| 2-0 2| 4-1
| 1-o 2| 2-0
| 1-0

Hence, (39),,=(100111),

Hence, (72),, = (1001000),
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© 2 | 128 d) 2 |55
2| 64-0 2 | 27-1
2 | 32-0 2 [13-1
2| 16-0 2| 6-1
2| s-o 2| 3-0
2 4-0 ] 1-1
2| 2-0 Hence, (55),, = (110111),
1-0

Hence, (128),, = (10000000),
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Hence, (173),, = (10101101),

2. Advanced Features of Windows 7

A. 1l (a) 2.(a) 3.(a) 4. (a)
B. 1T 2.T 3.F 4. T
C. 1. Hardware and Sound 2. Content
3. Partitions 4. Question mark
Let's Do It

A. 1. Windows Explorer helps us to organise and manage files and folders.
2. Appearance and Personalization
3. Asterisk (*) and Question mark (?)
4. Asterisk (*) and Question mark (?)

\
A
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1. Asterisk is used to replace a string of characters in the search term whereas, Question mark

2

replaces a single character or symbol.

. Wildcard is a special character which is used to represent one or more characters. Generally,
two wildcard characters are commonly used for searching files in a system. These are asterisk(*)
and question mark (?).

®
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Do yourself.
[ [
Periodic Assessment-1
(Based on chapters 1 & 2)
A. 1. A number system is simply a method of counting. Many different number systems exist.

Ul A W N

Consider a clock. Clocks have 24 hours, each hour composed of 60 minutes. Each minute is
in turn composed of 60 seconds.

. The Large Icons view displays large thumbnails (smaller than Extra Large Icons view) of the
files and folders.

. The hexadecimal number system consists of 16 digits from 0 to 9 and A to F. The letters A
to F represent decimal numbers from 10 to 15. The base of this number system is 16.

. The total number of digits used in a number system is called its base.

. Hexadecimal number system consists of 16 digits from 0 to 9 and A to F.

. The hard disk of a computer is divided into smaller parts known as partitions.
. Program is used to install or uninstall programs on the computer.

. Radix refers to the total number of digits used in a number system.

3. Computer Virus

(One Touch 'Learn i

A. 1.(a) 2.(a) 3.(c) 4. (b)
B. 1.T 2.T 3.F 4.7
C. 1 malware 2.antivirus 3. firewall 4. trojan horse
Lets Do It
A. 1. ATrojan horse conceals itself inside the software that seems legitimate.

N

2
3

. Antivirus program is used to identify and remove malware.
. Boot sector virus infects the boot sector or the Master Boot Record of hard disks or floppy

disks.

N
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4. Master Boot Record

B. 1. Amalware is a type of malicious program designed to damage or carryout other unwanted
actions on a computer system. worm, trojan horse, spyware, ramsomware, rootkit and
backdoor are the types of malware.

2. A computer virus is a ‘piece of code’ or program developed to corrupt the data or program
files stored on the computer system.

A computer worm is a type of malware that has the capability to replicate itself without any
human interaction. It consumes lots of memory space in replication.

3. An infected computer system will:
(i) Start displaying unusual messages on the screen.
(i) Load the programs late.
(iii) Take more time to shut down the windows.
4. (i) Download only legal software.
(i) Don't open any e-mail attachment from unknown sources.
(iii) Install an antivirus program in your computer system.

®
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Do yourself.

4. Advanced Features of PowerPoint 2010

(One /Touch 'Learn 25

A. 1.(a) 2.(c) 3. (b) 4. (a)

B. 1F 2.F 3.T

C. 1. InsertVideo 2. Text 3. slide 4. Shapes
@4

Let's Do It <

A. 1. Transition determines how your presentation moves from one slide to the next.
2. Slide transition is applied on the slides and animation is applied on the objects of the slides.
B. 1. Steps to insert a sound file:
Step 1 Click on Audio command on the Insert tab.
Step 2 Select the Audio from file option.
Step 3 Navigate and select the audio file to be inserted and click on Insert button.

|
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2. Action buttons help other people using our presentation in navigating from one slide to
another. In PowerPoint, 12 types of action buttons are available.

®
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Do yourself.
[ [
Periodic Assessment-2
(Based on chapters 3 & 4)

A. .

¢ = 1.3 v

Record button Stop Record button Play button Animation

B. 1.Spyware 2.RootKit 3.Backdoor 4. Worms 5. Antivirus

C. 1. Quickaccess toolbar is present on the title bar. It displays quick access buttons of Save, Undo,
Redo, etc. commands.

2. Action buttons help other people using our presentation in navigating from one slide to
another. We can also assign a particular task to do, when the viewer of the presentation clicks
on an action button.

3. Animations can be used in PowerPoint to make a presentation more interesting. They help
in giving a moving effect to text and other objects on a slide.

4. Transition determines how your presentation moves from one slide to the next. PowerPoint
provides several transition effects.

Test Sheet-1

(Based on chapters 1 to 4)

Section A
A. 1(0 2.(a) 3.(a) 4. (b) 5. (a)
6. (b) 7.(c) 8. (a) 9. (b) 10. (c)
B. 1.10,48,576 2. Shapes 3. trojan horse
4. malware 5. Question Mark 6. binary
C 1T 2.F 3.T 4.F 5T
Section-B

A . 1. Asterisk(*) and Question mark(?).
2. A Trojan horse conceals itself inside the software that seems legitimate.
3. Slide transition is applied on the slides and animation is applied on the objects of the slides.
4. Transition determines how your presentation moves from one slide to the next.

N
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. Master Boot Record
. Asterisk(*) and Question mark(?).
. The total number of digits used in a number system is called its base.

R N o un

. An infected computer system will:
(i) Start displaying unusual messages on the screen.
(i) Load the programs late.
(iii) Take more time to shut down the windows.

2. Multitasking

3. Action buttons help other people using our presentation in navigating from one slide to
another. In PowerPoint, 12 types of action buttons are available.

4. (i) Download only legal software.
(i) Don't open any e-mail attachment from unknown sources.
(iii) Install an antivirus program in your computer system.

5. Asterisk is used to replace a string of characters in the search term whereas, Question mark
replaces a single character or symbol.

6. To convert a decimal number into a binary number, follow these steps:
Step 1 Divide the decimal number by 2 (the base of the binary number system).
Step 2 Note down the quotient and the remainder.

Step 3 Divide the quotient obtained again by 2 and note down the resulting quotient and
remainder.

Step 4 Repeat the procedure till you reach a quotient less than 2.

Step 5 List the last quotient and all the remainders (moving from bottom to top). You have
your binary number.

5. Introduction to MS Excel 2010

(One /Touch 'Learn i

A. 1.(0) 2.(a) 3.(0) 4. (b)
B. 1T 2.F 3.T 4.7
C. 1. Excel 2. create 3. program  4.1048576

@

Let's Do It <

A. 1. Spreadsheet is a program that allows you to store and analyse numerical data.

2. The horizontal divisions on a worksheet are called rows and vertical divisions on a worksheet
are called columns.

3. 16, 384 columns

Ve
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B. 1.

2.

3.

[FUN

The data in the form of numbers or text can be entered by just clicking on a cell and typing
with the help of a keyboard. You can type data directly into the cell, or you can enter data
using the Formula bar.

(i) File Tab: A green button located at the left top corner that contains the file menu
commands such as New, Open, Save, etc.

(i) Ribbon: This bar has tabs with group of related commands displayed on it.
(iii) Name Box: The address of the active cell is displayed in this box.
There are manly three data types in Excel that are label, number and date/time.

®
lin | LAB L4

Do yourself.

6.

Editing in MS Excel

(One Touch Learn 2

A. 1() 2.(a) 3. (b) 4.(c) 5. (a)

B. llnsert 2. Cell Styles 3. Select All 4. Merge & Center

C. 1F 2.7 3.F 4.7 5T
Let's Do It

A. 1. Yes, we can unmerge the merged cells by using Unmerge Cells option.

!
N

2. Copy command is used to copy the content at new place and also exist its original place.
3.
1. Steps to wrap the text:

Wrap Text

Step 1 Click the cell in which you want to wrap the text.
Step 2 Click on Wrap Text command from Alignment group under Home tab.

. Steps to change column width/row height:

Step 1 Select the column(s) or row(s) that you want to change.
Step 2 Click on Format command in Cells group from Home tab.
Step 3 Choose Column Width or Row Heights.

Step 4 In the Column Width or Row Height box, type the value that you want your column
or row to be.

. Steps to apply cell border:

Step 1 On a worksheet, select the cell or range of cells that you want to add a border to,
change the border style on, or remove a border from.
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Step 2 Go to the Font group in the Home tab.
Step 3 Click the arrow next to Borders command.
Step 4 Click on the border style you would like.

4. Steps to rename a worksheet:

| FUN

Step 1 On the Worksheet tab bar, right-click the sheet tab that you want to rename.
Step 2 Click on Rename option and type in the name. .

®
lin | LAB L4

Do yourself.

7.

Formulas, Functions and Charts in MS Excel

(One Touch 'Learn i

A. 1 (b) 2. (a) 3. (b) 4. (c) 5. (¢) 6. (c)
B. 1.F 2.T 3.7 4.7 5F
C. 1Functions 2.equal 3. square root 4. column 5. Dollar ($)
Lets Do It
A. 1. Acell or arange of cells that you want to use in your calculation is called cell reference.

R N W N

. Legend is a key which shows the meanings of symbols and colours used in the chart.
. Area Chart is used to display the quantitative magnitude of the data graphically.

. Concatenate () function joins together two or more different text strings.

. The LEN function returns the length of the text string.

For example, Input=LEN("Excel”), will return 5.

. Rules to enter a functions are:

(i) All Excel functions must begin with = sign.

(ii) Function name must be a valid Excel name.

(iii) Function must be followed by opening and closing parenthesis.
(iv) Functions must contain an argument within it.

. A formula is an expression which calculates the value of a cell. Formulas in Microsoft Excel

begin with an equal sign. For example,

=10+ 20/5 + (5*4)

=20+ 60*10

Functions are predefined formulas in Excel to perform both simple and complex calculations.

) W
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They accept arguments and return values.

For example, Sum(range): It returns the sum of a range.
Input: =SUM(4,8,12,16)

Output: 40

. The Column chart is used to show the changes in data over a period of time or comparison
among the different data items and Scatter chart is used to show the correlations between
the two sets of values.

o
FUN [in | LAB L

Do yourself.

Periodic Assessment-3
(Based on chapters 5 to 7)

A
Bookl - Microsoft Excel

| Quick Access Toolbar |

v
ME9-c-19

File tab Home | Inset  Pagelayout  Formulas  Data  Review  View  Acrobat 2@ o b
% Calibri v - = oam(gl S General A gemset- X - Ac
= QD BZ U~ AAx EEEN $% St:s X Delete - (g~ S‘%;r leﬂz‘ -
Name box S | H- DA |FEEY | RN 2 Biremat- 2+ fners seea- (€77 Ribbon
Clipboard 1 Font Alignment | Number Cells Editing
> A = £ < Formula
- - T -
Highlighted = B c o e F s H i ) = bar
headings 2 - Column E
3 Active Cell Heading
- a
| Worksheet Window |1 » [ Mouse Pointer |
6
Row Heading 7 | Worksheet Tabs ;
8 s
W < » M| Sheet1 /Sheet2 ~Sheet3 |3 0Kl - m i | [l
| Ready | - |[Eo @ 100% (o) 0 o

Worksheet tab
scrolling buttons

Status bar

B. 1. It returns a number after rounding to specified digits.
2. It returns the absolute value of a given number.
3. It returns the length of the text string.

C. 1. Text wrapping displays multiple lines of text inside a cell.
2

. In Excel, the format of a cell is separate from the data that is stored in the cell. This display
difference can have a significant effect when the data is numeric. MS Excel provide 10 different

number formats which you can apply on the numeric values.

-
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8 Conditional and Looping Statements in
* BASIC-256

(One /Touch 'Learn i

A. 1.(a) 2.(c) 3.(a) 4. (a) 5. (b)
B. 1. control statement 2. WHILE 3. startNumber, endNumber
4. counter 5. infinite
cC. 1T 2.T 3.F 4. F 5T 6. F
Let's Do It

A. 1. TheIf-Then-Else statement checks to a condition.

2. Syntax of IF-THEN:
If <condition> Then
Statements to be executed
End If
Syntax of IF-THEN-ELSE:
IF <condition> THEN
Statements to be executed

ELSE
Statements to be executed
END IF
3. a. 30 times
b. sum = 145
B. 1 l
N fs Y
o condition €s
; true i
Execute Execute
commands in commands in
the ELSE block the IF block

!

2. This set of instructions will repeat for a fixed number of times or until a condition is satisfied.
This is called looping.

BASIC-256 provides FOR...NEXT and WHILE..END WHILE as looping statements.

3. Syntax of the WHILE...END...WHILE loop is:
While (condition is true)

) W
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Statements to Repeat

|4

End While \A
Flow chart of the WHILE...END... WHILE loop: True = Execute statements
Condition? —» inthe body of the
] ] WHILE loop.
C. 1.Thad 1slice of pizza.

I had 2 slices of pizza. False l

I had 3 slices of pizza. Move to the
. . statement after the

I had 4 slices of pizza. END WHILE keyboard

I had 5 slices of pizza.
I had 6 slices of pizza.
I had 7 slices of pizza.
I had 8 slices of pizza.
I had 9 slices of pizza.
I had 10 slices of pizza.

2. Ihad 1 slicec of pizza.
I had 2 slices of pizza.
I had 3 slices of pizza.
I had 4 slices of pizza.
I had 5 slices of pizza.
I had 6 slices of pizza.
I had 7 slices of pizza.
I had 8 slices of pizza.
I had 9 slices of pizza.
I had 10 slices of pizza.

3. Sum =190

4.1
4
7

®
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Do yourself.
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9. Impacts of IT

(One /Touch 'Learn i

A. 1.(a) 2. (b) 3.(c) 4. (b)
B. 1T 2.F 3.F 4.7 5.F
C. 1. Trademark 2.Plagiarism 3. Patent 4. Phishing 5. Spam
Let's Do It
A. 1. Software piracy means illegal use of software. This means that you have not bought software
or you don’t have permission to use it.
2. Hacking is the unauthorised access of a computer system for the purpose of destroying the
system or stealing important information from the system.
3. Copyright and Trademark
4. (i) Don't stay quiet and don't protect the bully.
(i) Don't disclose your personal information like address, phone number and school name
online with unknown people.
5. Computer Ethics etiquettes that tell us how to use the internet wisely.
B. 1. Patentis the right that gives an inventor the complete right to make, use, and sell his or her

_FUN in | LAB L

work for a specific time period. Usually the validity period for a Patent is 20 years.

Trademark is a symbol or word legally registered or established and used as representing a
company or a product. The validity period for a Trademark is 10 years and can be renewed
after that.

. Internet is a network used all over the world where users located at different locations can

communicate and exchange information with each other.
Disadvantages of Internet:
(i) Cyber Crimes (i) Wastage of Time (iii) Loss of Personal Information

. (i) We should use quotation marks to write the word or lines written by someone else.

(i) We should rephrase the content as per our requirement to avoid Plagiarism.
(iii) We should always mention the source of information.

. (i) Install updated antivirus in your computer system.

(i) Be cautious while using your password online.
(i) Avoid friend requests from strangers.

Do yourself.

) W
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Periodic Assessment-4

(Based on chapters 8 & 9)
A. ( Title bar )_,ﬁumiﬂedl»msm-zss . EIE@]
File Edit View Run Window Help
9 H H ’ ” e i ov L‘/
New Open Save | Run Debug Step Runto Stop | Undo Redo Cut Copy Paste
Untitled 1 £ I Text Output g X

1| Copy Paste Print Clear

|Graphics Output
Copy Print Clear

]
o]

Text Output
Area

Line: 1 Character: 0

Output Area

B. 1. Plagiarism is simply taking other person’s work, and instead of giving credit to the person

who actually prepared that, presenting it as your own work.

2. Phishing is a cyber crime in which an e-mail that falsely claims to be from a trusted organisation
is sent to a user. This type of e-mails generally contain a link of a website.

3. Software piracy means illegal use of software. This means that you have not bought software

or you don’t have permission to use it.

Test Sheet-2

(Based on chapters 5 to 9)

Section A

A. 1. (0 2. (c) 3.(a) 4. (o) 5. (b) 6. (b) 7. (c)

B. 1. Excel 2. program 3. Select All 4. insert
6. column 7. control statement 8. counter

C. 1T 2.T 3.F 4.7 5.F 6.T 7.F

Section B

8. (a)

9. (a) 10.(c)
5. equal

A. 1. Spreadsheet is a program that allows you to store and analyse numerical data.

2. Copy command is used to copy the content at new place and also exist its original place.

Steps to change Theme Background:

3. Legend is a key which shows the meanings of symbols and colours used in the chart.

4. The If-Then-Else statement checks for a condition. If the condition evaluates to true, the
indented statements following the if statements are executed, otherwise the indented

statements following the else statement are executed.

N
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. Copyright and Trademark

1. There are manly three data types in Excel that are label, number and date/time.

2. Steps to change column width/row height:

Step 1 Select the column(s) or row(s) that you want to change.
Step 2 Click on Format command in Cells group from Home tab.
Step 3 Choose Column Width or Row Heights.

Step 4 In the Column Width or Row Height box, type the value that you want your column
or row to be.

. The Column chart is used to show the changes in data over a period of time or comparison
among the different data items and Scatter chart is used to show the correlations between
the two sets of values.

. This set of instructions will repeat for a fixed number of times or until a condition is satisfied.
This is called looping.

BASIC-256 provides FOR...NEXT and WHILE..END WHILE as looping statements.

. (i) We should use quotation marks to write the word or lines written by someone else.
(i) We should rephrase the content as per our requirement to avoid Plagiarism.

(iii) We should always mention the source of information.

) W
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